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[bookmark: _Toc403043494]SharePoint
[bookmark: _Toc403043495]Accessing documents in SharePoint
The books we are editing in the Alt-Text Lab are stored in a Microsoft based program called SharePoint.  We access book files for alt-text editing by checking them out from the SDRC SharePoint portal and checking them back in after editing.
To access SharePoint, open an Internet browser.  You can edit books using Firefox or Chrome, but SharePoint works best with Internet Explorer (IE) because it’s a compatible Microsoft product. If you check out a file for editing using a browser other than Internet Explorer and find that it’s not behaving as you would expect, try closing and checking in your file and reopening it (checking out) using Internet Explorer.  
To access the SDRC SharePoint Alt-Text portal, navigate to https://sdrc.intranet.fsu.edu. Log in with your FSU user name and password. If using IE add “@fsu.edu” to the end of your user name.  The SharePoint site will appear with information according to your permission level.  Alt-Text Staff have greater permissions than Work Study and volunteers.  So there will be some tasks that can only be completed when logged in by those with greater permissions.
To navigate to the book you are going to edit, click on “books in progress” located on the left side of the screen in the links list panel. The available books in progress will appear as folders. Click on the folder of the book you will edit. The folder should contain PDF and Word files. You will need the Word document for the chapter you are editing.  If you are not using the actual book to check on content, you will need to open the PDF of that chapter also.   
[bookmark: _Toc403043496]Check Out
To open Word: Move cursor to the right of the title to see an arrow “open menu.”  Click on the arrow, and on the drop-down menu choose “check out.”  A new window says, “You are about to check out.” If there is a box “use my local drafts folder,” make sure it is unchecked.  Click OK.
Another way to open the document is to click on the title.  You will be given the default option of “read only” or you can choose “check-out and edit.” Click on “check-out and edit.”  The document should be available for edit after it opens.
If you open in “read only,” once the document is open there is an option on the top to “enable editing.”  Click and a “check out” box will appear at the top of the page.  Click on it and you will be able to edit the document.
To open the PDF or PowerPoint: go to the drop-down menu on the right of the title and choose “send to,” “download a copy.”  The PDF or PPT will open as a separate document, not in a browser window.  If you click directly on the PDF or PPT document and it opens, it will open in the same browser window as SharePoint.  To get back to SharePoint, do not close that window.  Click on the back arrow on the top left of the screen for previous window.
Edit the document according to guidelines.  
[bookmark: _Toc403043497]Check In
When finished editing, it is important to properly check in the file. If you do not check in the file, all your work may be lost once you log off the computer.  We don’t want that to happen!
Check in: Save and close the file. A window appears “Other users cannot see your changes until you check in. Do you want to check in now?” Click “yes.” Another window appears “Check-in version comment box.” Leave box empty.  Click “OK.”  
Once the document closes, you are back to the list of documents for this book.  There are two green arrows that may appear on the Word icon of the chapter you checked in.  One points up indicating check-in is necessary and one points down for a check-out option. These options are also seen on the drop-down menu to the right of the title.  Only one type of green arrow can appear at a time, depending on whether the file is already checked in.  Look to make sure there is no green arrow pointing up. If there is, press F5 to refresh the page.  A “Windows Internet Explorer” window will appear.  Click “retry.”  After refreshing if the arrow still appears, the file is probably not checked in.  Go through check-in procedure again.  You can also check the drop-down box and see if the “Check out” option is available. If it is, the file is checked in. If you have any questions about whether a file is properly checked in please ask for assistance.  We do not want to lose your work! Save it on a flash drive and a staff member will upload it to SharePoint.
There is no need to save or check in the PDF if you downloaded it when opening.  Simply close the document. 
[bookmark: _Toc403043498]Reporting completed work
[bookmark: _Toc403043499]Calendar
Use the calendar to keep track of and report the work you have done during your session. Staff will use this report to track the amount of time it takes to complete each book.  Your information is also used to determine where the next editing session should begin.  Staff reviews all alt-text work before publishing to SharePoint for the student.  The report lets us know what you’ve done and which pages need review.
On the left sidebar of the SharePoint main page, click on “calendar” and the present day will come up.  If you need a different day, click on the arrows at the top to find the day you did the work and enter your report there.  Hover the cursor on the right side of any blank line and “add” will come up.  You can also double click on the calendar and the new window will open.  Complete the information about your session. Follow these instructions for filling out the form:
Title: book title.
Name: your name.
Start time/End time: fill in the time or select from the drop-down menu.  Select times in 15 minute increments.  Round to the closer time if it’s more or less than 15 minutes.
Total time: Enter total amount of time spent in your session. Examples:  1.0 (1 hour); .75 (45 minutes); .5 (30 minutes), or .25 (15 minutes).
Description: note which chapters you completed, whether or not you finished the chapter or file, page you ended on, and any other information pertinent to others knowing what you did and where to begin the next session.
Category: use the drop-down menu to choose your work category—Editing, ABBYYing, Scanning. Only one category can be selected, so if you worked in more than one category, please make another calendar entry. 
Position: This defaults to “staff,” so click on the position you hold if you are not staff—OPS, work study, volunteer. Save and the window will close.  
Only staff can edit the calendar once an entry has been saved.  If you need to edit your entry, ask a staff member to help you. 
[bookmark: _Toc403043500]Editing
The purpose of editing is to make available to the student all the information on each page of the book or article that is available to a person using the printed book. The screen reader should read the page in an order that is logical and easy for the student to follow.  The editor does not add words to the published text unless necessary for clarity of presentation of the information.  This addition is called a description. We also do not correct spelling errors in the original text.
Each book is prepared with a specific student’s access accommodations in mind. Therefore some books require more editing than others, depending on the accommodation needed.  Students who can see the page in the textbook may use the screen reader and follow along with the reading.  Such a student can see the graphics or special sections in the textbook, making additional description unnecessary.  
Students with no or low vision have a special need for the text to flow in an orderly fashion so the meaning of the information is clear.  Specific set phrases are used to signal the beginning and end of inserts, figures, tables, and graphs. Graphics such as photographs and images may need to be described if there is an insufficient description in the text or caption to impart the information the student expects to learn.
If you are not sure what type of editing is needed for the book you are preparing, please ask. Questions are always welcome!  It is better to ask questions than to edit incorrectly, causing even more editing to be needed.
[bookmark: _Toc403043501]Basic Editing
[bookmark: _Toc403043502]Page numbers
All pages in a document begin with a page number.  The screen view of a page, what we see on the computer monitor, is not the same as the page recognized by the screen reader as it reads through the document.  An actual page begins with the page break and announcement of the page number and may be longer than one, or even two, pages as viewed on the computer screen.
The Front Matter of most books contains Roman numerals as page numbers. Roman numerals are not recognized as numbers by the reading programs.  Change the Roman numeral to “Page Roman numeral _.” If there is no number on the page, count forward or backward in the book from a named page number to determine the correct page number where it is missing. 
Sometimes when the book is converted from PDF to text, page numbers may be added or dropped.  Do not assume the number printed in the text is the correct one for that page. Refer to the book or PDF for verification.  Even if there does not seem to be a discrepancy in the document, periodically check the page number against the original text to make sure it’s right.
If a page begins with a table, the page number may have been dropped. It may be difficult to insert the page number without manipulating the hidden editing marks in the text.  To turn on the hidden marks and see where a section break occurs, on the “home” tab turn on the paragraph marks ¶.  Click at the beginning of the section break and hit Delete.  The section break should disappear.  You can then Enter to create a return (appearing as ¶) where you can insert a page number at the top of the page.  If you need help, please ask how to create space for a page number.
At the end of a chapter or section of a book there may be a blank page.  This page must be accounted for in the completed document as it will have a page number.  The format for blank pages is to add a page break, page number, and enter to a new line.  Add the words “This page is intentionally left blank.”
Unnumbered pages containing photographs are considered to be part of the previous page.
[bookmark: _Toc403043503]Page breaks
Insert a page break at the end of the text on the bottom of each page. To create a page break, press ctrl + enter. If this moves the new page to a blank screen page, put the cursor on the blank page and hit backspace until the screen moves up.  Check to make sure the page break is still there on the previous page by turning on the paragraph marks.
[bookmark: _Toc403043504]Sentences
Sentences should end at the bottom of a page and not wrap to the next page. If the sentence crosses the page break, the page number will be announced in the middle of the sentence. Move the words in the sentence to one page.  Usually the part of the sentence with fewer words is moved to the page with more words.  Some exceptions occur, as when there is a footnote in the sentence.  In that case, move the entire sentence to the page where the footnote number is located with the note at the bottom of the page.  If there are end notes instead of footnotes, it doesn’t matter which page the sentence is on. If the sentence is the last or first one in a paragraph, move it to the page with the rest of the paragraph.
[bookmark: _Toc403043505]Headings
The Headings feature will provide an outline format for navigating the sections of the document when the navigation pane is visible.  To see the navigation pane, in the View tab click on “navigation pane” or “document map.” The navigation pane will appear on the left side of the document showing all the headings. The student can go directly to a particular section of the document by clicking on the heading for that section. 
To create headings in the document, place the cursor in front of or on the wording you want to mark as a heading.  Hold ctrl + alt as you press a number.  The numbers 1 through 4 create four levels of headings. 
1: chapter title
2: main section titles in the chapter
3: sub-titles in the chapter
4: divisions of material within the sub-titles.
Headings may also be created by going to Styles on the Home tab and clicking on the button for the heading you want to apply, UA H1, UA H2, UA H3, UA H4.  If you apply a heading and want to remove it, either undo with ctrl + Z or click on “UA Normal” or “No Spacing” on the Styles tab.
Most chapters will have headings 1 and 2. Some have heading 3, and less frequently heading 4 is necessary.  One way to decide which titles and subtitles should be headings is to check the table of contents.  If there is a detailed table of contents, the headings will follow the organization of the topics.  The original text in the book or PDF will also indicate the headings with font sizes, styles, and colors.  Once heading style has been established for a book, all the chapters should include applying headings in the same order.  If you are unsure how to use the headings feature or which headings to mark at which levels, please ask.
[bookmark: _Toc403043506]Font and Line Spacing
Unless otherwise stated, all fonts will be Arial, Calibri, or Times New Roman 11.  The conversion from PDF to Word will apply the font and the entire document should be in the same font.  When formatting is removed from sections of text, the font may revert to a different text from the rest of the document.  Select the words and change it to the main font.  If you want to enlarge the words on the screen view, increase the magnification by ctrl + scroll up.  Decrease magnification by ctrl + scroll down.
All fonts are normal without bold, italics, or underlining unless you are specifically directed to add these features.  If the text of the book uses these features and you think they are necessary to the student’s understanding, please ask a staff member before using them.  The student will need to turn on special features of the screen reader program in order to detect the special fonts, so we only use them in special circumstances.
Paragraphs are separated by a blank line entered between them.  There is also a blank line before and after a heading, before a figure/table/graph heading and the figure, etc. There is no need to add additional blank lines for emphasis. 
The computer may default to a screen view with extra spacing between the lines.  In this case the actual line spacing in the document may be confusing to you as the editor.  To see the single line view, select the entire document by holding ctrl + A .  In the Home tab click on the arrow to the bottom right of “paragraph” and the paragraph screen will open.  Under “spacing” change the “before” and “after” to “0 pt” and “line spacing” to “single.”  “OK.” 
All lines are left justified.  There is no need to tab or indent to mimic the book format, as the screen reader will interpret this as an extra long pause in the voice as it reads.  It is also important for documents that will be embossed in Braille to be left justified.  If lines in the text are not left justified, adjust them with the controls in the “Paragraph” section of the Home tab. If formatting will not allow a line to return to the left margin, click on the “decrease indent” button under “Paragraph.”

Special texts
Poetry is usually formatted in a particular line style that should be preserved in the editing process. When poetry is converted from PDF to text the lines may disappear, making the text looks like one long paragraph.  Often the new line is signaled by a capital letter.  If you cannot be sure of the lines using capital letters only, click on the ¶ in the home tab to see the hidden editing marks on the screen.  Wherever there is a ¶, Enter to move to a new line. Refer to the original source or PDF to make sure the line spacing and punctuation are correct.
Poetry may contain line numbers.  Retain the line numbers in the text, being consistent with either putting them at the beginning or the end of the line.  Put the numbers in (parentheses) to distinguish the line numbers from the text. You will be directed if a different format should be used.
Plays are formatted with each voice on a separate line labeled with the name of the speaker and have a blank line between the speakers.  It can be difficult to find the names of the speakers when the lines look like one long paragraph.  Try turning on the paragraph mark ¶ and entering a new line after each one.  Consult the original text frequently to make sure all the voices are placed correctly on new lines.
[bookmark: _Toc403043507]Keyboard shortcuts
There are keyboard shortcuts you can use to more easily edit the text.  Here is a list of some of the more commonly used shortcuts.
Undo action: ctrl + Z.
Cut: ctrl + X.
Copy: ctrl + C.
Paste: ctrl + V.
Select the entire document: ctrl + A.
Insert page break: ctrl + enter.
Refresh an online page: F5.
Accent tilting right-é: ctrl + apostrophe + letter.
Accent tilting left-è: ctrl + left accent + letter.  This key is usually found on the upper left side of the board with the ~.
Capitalize letters for selected words: ctrl + shift + A.
Increase/decrease size of text on view screen: ctrl + scroll up/down.
Superscript: Ctrl + shift + plus (+)
Subscript: Ctrl + shift + =
[bookmark: _Toc403043508]Ending an editing session
When the document is not finished at the end of your editing session, highlight the sentence where you stopped.  This makes it easier for you or another person to know where to begin the next time. Close the document and enter your work into the calendar according to directions on using SharePoint.
[bookmark: _Toc403043509]Advanced Editing
[bookmark: _Toc403043510]Page Organization
Many pages in books or articles are organized simply with one or two columns of text with occasional photographs or figures.  These pages are not difficult to format.  Other pages are more complicated, with multiple types of formatting items to make the page look attractive to someone who is looking at it.  It can be confusing for someone who can only listen and does not see the page to follow the sense of the text paragraphs when they are divided by other items.  
To make the best sense of the information on the page, keep the sentences in a paragraph together in one block of text. When figures interrupt the flow of the paragraph, it is acceptable to move paragraphs as long as they remain on the original page. Place the figures after the paragraph where they seem to make the most sense.  When a paragraph wraps from one page to the next, situate it at the end of the page so the sentences flow directly to the next page.
Definitions are usually put at the top of the section where they apply.  If you have questions about how to organize the various sections on a page, please ask for help. 
[bookmark: _Toc403043511]Inserts
Inserts are sections of text that are distinct stories or information separated from the rest of the chapter with a box or background color shading.  They usually have a title and may include photos, graphs, or tables.  The wording format for inserts is: The title followed by the text of the insert on the next line.  Follow usual formatting procedures for any photos, graphs, or tables within the insert.  If the insert spans more than one page, position it so that it flows directly from the bottom of one page to the top of the next page.  If the original text includes “continued,” keep that word in the editing.  There is no need to add “continued” if it is not in the original text. End the section with “End insert.”
Make sure that the insert is not interrupted by other text.  When the PDF is converted to Word, it is common for the insert to be found mixed with the regular text on that next page.  You may need to look for it and move it to the top of the page to avoid confusion for the student.  
[bookmark: _Toc403043512]Notes
Many books contain notes in one format or another that will be consistent within a book or document. Most commonly a footnote contains a superscripted number in the text with the note at the bottom of the page.  There may be superscripted numbers in the text with all the notes at the end of the chapter or in a separate section at the end of the book.  These are end notes.  Sometimes the note is not superscripted; it may look like a regular number or be in parentheses and refer to a resource in the bibliography section of the book.  When we edit, we recreate the type of note format in the original printed material.
Footnotes
All the footnotes in the text on a certain page should appear at the bottom of the same page as in the original text.  Superscript the footnote number in the text by selecting the number and clicking on “X2” in the Font selection on the Home tab or ctrl + shift + plus (+). Precede each footnote with “Footnote number:” and end with “End footnote.” If there are several footnotes on a page, the footnote announcement can occur once at the beginning as “Footnotes:” with “End footnotes.” after the final footnote. 
Footnotes in special format will attach to the superscripted number so that a little window with the text of the note appears when the cursor hovers over the number.  You will know this has happened when the footnote appears at the bottom of the page in an italicized font with a horizontal line above it and cannot be moved or removed. 
This format is quite handy for the student who can easily see the window.  However, the problem is that the format will not be consistent throughout the entire document, with some footnotes being visible in that way and some appearing as part of the regular text.  Footnotes as part of the text will be in the font of the text and are moveable by cutting or dragging. They may not appear where you expect at the bottom of the page and the number will not be superscripted in the text; the number may be missing completely in the text or changed to an asterisk or other character. Occasionally footnotes seem to be completely gone and may be found at the end of the document, with or without a number.
In order to remove confusion for the student, we correct all footnotes to a common format. If you remove the superscripted number, the italicized footnote will disappear and be lost.  To prevent this from happening: 
1. Select and copy (ctrl + C) the text of the footnote. 
2. Paste (ctrl + V) it at the end of the page where it appears in the original text.
3. Select the text of the footnote that was just pasted and click on “Clear All Formatting” in the Home tab to the right of the “Grow/Shrink Font” boxes. This removes special formatting and puts the wording into the same font as the rest of the text in the document.  
4. If the font and/or size of the footnote are not the same as the rest of the document, select the pasted note and change them to conform to the rest of the document.
5. In the text, select the superscripted number and click on “X2” in the Home tab to superscript the new number. Type in the correct footnote number.  The screen will ask if you really want to delete the previous number.  Yes, finish typing and the new number will appear. By deleting the superscript connected to the footnote formatted on the bottom of the page, that footnote text disappears. The pasted footnote remains.
6. You will notice that the number of the next italicized footnote has changed and become the number you just deleted. Changing the footnote will adjust the numbers. 
7. For footnotes not in specialized format, select the text of the note and drag to the proper position on the page. Create a correct superscripted number within the paragraph.
As you edit the text, check to make sure you find and correct all the footnotes so they are in numerical order consistent with the original.  If there are notes that you cannot find within the text of the current or next page, and they are not located at the end of the document, you will need to add the superscripted number at the correct place in the text and retype the footnote at the bottom of the page.  Please ask if you have any questions about footnotes.
Endnotes
Endnotes usually do not appear in the specialized formatting with italicized font.  They may need correction of the numbers and the superscript may need to be added.  Generally they are easier to manage and edit than footnotes.  Check the endnotes section at the end of the chapter or book to make sure you have found all the notes located in the chapter.
[bookmark: _Toc403043513]Bulleted lists
The screen reader does not recognize bullets, and frequently the bullets disappear partially or totally in the conversion from PDF to Word format.  Bullets can be recreated as numbers or hyphens so the list will remain orderly.  In the Home tab, Paragraph, use the “Numbering” button to create a numbered list on a single page.  If the list continues to another page, when you apply the numbered list the numbers will begin at 1 again.  If you want the numbering to continue from the previous page, right click at the first number on the new page and choose “Continue Numbering.” Check to make sure the bullet numbers agree with the original list. If lists are numbered in the original text, use numbers in the edited text.
For shorter lists or in PowerPoint conversions where each slide may have bullets, use hyphens to indicate levels of information.  Students who use JAWS will understand the meaning of levels of information using hyphens.  The screen reader will say “hyphen, hyphen” indicating both are present. One hyphen - is the first level.  Two hyphens- - are the second level.  For a third level, incorporate the information into the second level sentence.  
[bookmark: _Toc403043514]Descriptions 
Within the text there may be images, photographs, tables, or graphs that enhance the information content with visual interest.  Any of these may be called a figure, table, or appear on the page independently of any title. In order for a student with low or no vision to access all the information on a page, it may be necessary to describe them.  
Images, photographs, tables, and graphs will need individual description methods depending on the purpose and complexity of the information presented.  Be as clear and concise as possible when describing them.  Each description should be considered on the basis of how the bits of information relate to each other.  At the end of the description process, all the information in the original should be present on the edited page. It is expected that you will have questions on how to describe a long or difficult figure, graph, or table.  If you do not think you can adequately describe the information or have questions about what you’ve done, please highlight the section and notify a staff member that it needs review.  You can note this in the calendar when you log your time and work accomplished. 
[bookmark: _Toc403043515]Images
Information saved as images will be recognized by the screen reader and voiced as “image” without a description of the content.  Therefore, for students with no vision, images must be described in the Word document.  If the information was saved as an image because the words could not be recognized as text in the conversion from PDF, then type out the words and delete the image.   If the image is a photo, illustration, or drawing, then do not delete it from the document.  If the document is used in the future by someone with sight, these images will be preserved and enhance the student’s education experience. For most people with no vision, color and shape are not pertinent and need not be included in the description unless they are used to designate how information is organized.
Photographs
Many photographs will have captions.  Place the caption after the photo, as the student will hear “image” and expect a caption or explanation to follow. The wording format for photograph captions is: “Caption:” at the beginning and “End caption.” at the end. If the caption describes the photo, then further description is unnecessary.  Any additional description is added with the wording “Description:” and “End description.”  
When describing a photograph, consider the type and purpose of the book. A history book has a different intent than an art or design book.  Different aspects of the photograph or image will be considered pertinent to a thorough description depending on the purpose of including it.  Ask for assistance before you begin photograph descriptions.
Flow charts
An image may be a flow chart filled with boxes and arrows pointing in various directions. Various shapes may designate specific types of information.  In that case naming the shape along with stating the information helps the student to better identify it.  Look at the structure and flow of information on the chart. Consider how to organize it to make it easy to follow when heard.  The simplest flow charts can be described by using the exact wording in the box and linking the boxes with the phrase “flows to.” For more complicated flow charts, double check to make sure all the flows have been described.
Maps
Maps are often color coordinated with specific information stated in the legend.  The colors are visual cues and not pertinent to describing the information on the map. Use the categories on the legend to list the information the map offers. Make sure all information from the map is included in the description. 
[bookmark: _Toc403043516]Tables
Tables organize information with rows and columns creating individual cells for particular facts.  If the student has sight or can navigate tables, the table can remain and will not need to be taken out of table format. The table structure may need to be adjusted to reflect what it looks like in the original document and you can do that by using the following tools. You will be told whether the tables in the document you are editing need to be removed from table format.  
Whether the table will remain or be taken out of table format, it must first look like the original so you can verify that all the information is in its proper cell. This makes the information easier to edit when taken out of table format. Use the following tools to create a table that looks like the one in the original document. 
Begin with table “Table (name)” and end with “End table.”
Borders and shading 
First turn on the lines so you can see what information is in which cells and how they relate to each other.  Hover the curser on the top left just outside the table and click on the small box to highlight the entire table.  Right click for the drop-down menu and select “Borders and shading.”  On the “Borders” tab click on “Grid” to turn on the lines.  OK. The lines will show whether words or phrases that belong together are split between multiple cells or if there are extraneous empty cells that need to be merged. 
If any cells are darkened, highlight the table, right-click to choose “Borders and Shading,” “Shading.” Click on “Fill” “No Color.” Even if the setting seems to already be on No Color, select it again and the shading will disappear.
Merge/split cells
Information, such as a title or column heading, may be spread among multiple cells instead of only one cell. If you move the information all into one cell, the remaining cells will be empty and those empty cells will be read as blanks, confusing the reader as to their purpose.  If you try to delete the empty cells the structure of the table will be compromised.  The best way to make the change and keep the structure is to merge cells. Select the cells you want to merge.  Right click and choose “Merge Cells” from the drop-down menu.  Edit the words so they read smoothly, with proper spacing and whatever punctuation or footnotes are contained in the original.
If there are cells missing and the rows or columns do not line up like the original, a cell can be divided into two or more parts.  Select the cell you want to change.  Right click and choose “Split Cells” on the drop-down menu.  Enter the number of rows and columns needed. If the cells will not split as you need, it may be because that number of rows or columns is incompatible with the present structure of the table.  Ask a staff member for help if you cannot resolve the problem.
Insert/delete rows and columns
Rows and columns can be added and deleted to re-create the correct table structure. Select the cell next to where you want to add a row or column.  Right click and choose “Insert” in the drop down menu. Choose the row or column position to the right, left, above, or below the cell where the curser is located.
To delete, select the cell or cells you want to delete, right click and choose “Delete” from the drop-down menu.  Choose the option you need from the new window.
Removing information from a table and reorganizing it in a columnar form
First, look at the data to decide how to use the column and row headings to create a structure for presenting the information outside the table.  These headings will group the information so that all data from a column or row will relate to the rest of the information in a way similar to how it is organized in the cells.  Please speak to a staff member if you are unsure how to organize it in a clear, understandable way. 
To remove the information from the table, highlight the table and the Table Tools toolbar will appear at the top of the screen.  In Table Tools click on “Layout,” “Convert to Text.” The “Convert Table to Text” window appears and defaults to “Tab,” which is usually best as it uses tabs to keep the information on the same row as it was in the table. The information will now be in lines with tabs in between the data that was in the cells.  Each row should be on a separate line. If you choose an option and it doesn’t work, ctrl + Z will undo the action.  Then you can use the “paragraph” option.
To present the information in a clear way, use the column or row headings to designate groups of information.  Most commonly, the column headings are the topic of the large groups of information and the row headings are the types of information within the group. Create a short list of the row headings to be used with the punctuation needed for the final view.  Copy and paste that list on the following lines as many times as necessary to accommodate the number of entries in the rows.  Repeat the list of row headings for each additional column heading and set up the entire structure before moving the information into place. Separate the column sections with a blank line. 
Select and drag the information to the correct place in the column structure.  Continue until all the information is moved.  Double-check to make sure all information is included in the new format.  Use the original document to double check for notes, footnotes, or other items that may need to be added.  Notes should be located at the end of the data.
[bookmark: _Toc403043517]Graphs
There are different types of graph styles to organize information. 
Line graphs organize information with the y-axis naming what is measured and x-axis naming how it is measured.  The line is formed when the points of the graph are connected.  Some line graphs include multiple categories with a legend on the side designating which shape/color of line is showing which type of information.  Other line graphs place the lines one on top of the other so that together they add up to the total measurement.  The area under each separate line measures only from the line down to the previous line and not to the bottom of the graph (x-axis).  In this case, each line must be calculated carefully to be sure to impart the correct information in the graph description. 
Depending on the subject matter, the graph may be best described in general terms, or the value of the specific points may need to be detailed in the description. In this case, a qualifier is used in the description. “All numbers are approximate.” In general, describe line graphs as follows. If this wording does not make sense for the graph you are describing, adjust it so it does make sense. 
EXAMPLE: “Description. The graph measures (title of y-axis) from (bottom number) to (top number) in increments of (amount between numbers on the y-axis) for (title of x-axis) from (left number) to (right number) in increments of (amount between numbers on the x-axis.  All numbers are approximate.”
Bar graphs show the information in the form of vertical or horizontal bars within the graphing area. Often the value of the bars is given and no qualifier is necessary when giving values to the bars.
Pie graphs show the information in the form of a circle with slices sized to the percentage of each category of information measured. If the values are given, then no qualifier is needed.  If values are not given, approximate the values and give the qualifier.
[bookmark: _Toc403043518]ABBYY FineReader11
ABBYY FineReader11 converts PDF documents into text documents.  It also changes a scanned document into a text or readable PDF document.  The components of each page are recognized as one of three areas: text, table, or picture (image).  After all the pages of the document are recognized, the program reads the entire document; then it can be saved as PDF or Word text.
[bookmark: _Toc403043519]Opening a PDF document
Click on “Open” on the top toolbar.  The window will appear to select the PDF from the drive.  Double click to open the desired PDF document.  The ABBYY program will not open a document from a zipped folder. If the PDF you wish to convert is in a zipped folder, unzip the folder before opening the file in ABBYY.  
Choose the Document Language on the drop-down menu on the toolbar.  The “autoselect” option will recognize English, French, German, Italian, and Spanish together in the same document. By selecting the language, the diacritical marks on letters in the language will be preserved and make editing easier. 
[bookmark: _Toc403043520]Deleting Pages
Scroll down or up to navigate to the next or previous page.  Look through the document to see which pages are included at the beginning and end.
When book chapters are scanned, the page beginning a chapter may face the page that ends the previous chapter, or at the end, the next chapter may begin on a facing page.  That page from the previous or following chapter should be deleted from the FineReader document for this chapter.  Click on the thumbnail of the page to be deleted and press the delete key.  Make sure only that page is selected before deleting as the operation cannot be undone. 
If there is a blank page at the beginning or end of a document, delete it from FineReader.  It will be restored when the Word document is edited.
[bookmark: _Toc403043521]Recognition Areas
ABBYY is usually set to recognize areas automatically.  When the document opens, all the parts on the page will be recognized.  The recognition areas are color coded; text is green, table is blue, picture is red.  Background picture is used when there is text over a picture; it recognizes both the image and the text.  If no recognition area has been chosen, the outline will be gray and will not remain on the screen after the cursor is released.  Text, table, and picture are the most frequently used areas.
When set to automatic recognition, areas are recognized as a type the computer thinks it should be. Some areas will need to be changed or deleted because they are the incorrect type or are unnecessary in the finished document.  Delete headers, footers, and page numbers on all pages, as they are redundant and page numbers are assigned when the macro is run on the new Word document.  There may be extraneous areas recognized that do not have text or images in them.  These extra areas may be near the margins and should be deleted.  If recognition areas on the entire page are to be deleted, right click on the page and choose “delete all areas and text.”
The recognition area can be changed by clicking on the desired icon on the toolbar before using the cursor to draw the box around it, or after the area is selected by using keyboard shortcuts.  Click on the area and then press the keystrokes for the desired area. Text: ctrl + 2; table: ctrl + 3; picture: ctrl + 4; background picture ctrl + 6; barcode ctrl + 5.  
Sometimes there are multiple recognition areas of different types overlapping on sections of the page.  When this happens, unnecessary areas are deleted and one area can be left and expanded to cover the desired material.  Pull the sides to cover the area to be recognized.  Change the area recognition type if necessary.  Doing this preserves the order of the area on the page.  
[bookmark: _Toc403043522]Ordering Areas
The order in which the areas are created on the page determines the order the information will appear on the page in the Word version.  The more complicated the layout of information on a page, the more important that the areas are ordered according to how the information should be read in the Word version. 
When areas are automatically recognized, the computer, not the user, has set the order.  For simple formatting such as text with few or no images or tables, the automatic recognition will work well. If the order needs to be changed, click on Areas in the toolbar, and “Order Areas” in the drop-down menu.  Numbers will appear in each recognition area to denote the order they will be recognized on the page. Begin clicking on the areas in the order you want them to appear in the final document to establish the new order.
For complicated orders of formatting, manual recognition is preferred.  To manually recognize the order of areas, open the document and it will automatically recognize the pages.  Click on Tools, Options. On the Scan/Open tab click “Do not read and analyze acquired page images automatically.”  OK. Subsequent documents will not be automatically recognized and you can manually choose each of the areas until the program is reset to automatic recognition.
[bookmark: _Toc403043523]Tables
Look over the tables to make sure all the horizontal and vertical separators are properly placed.  In general, the title at the top of the table and sources/footnotes below the table should be recognized separately as text areas, not cells in the table.  If changes need to be made, click inside the table and the toolbar will appear.  There are vertical, horizontal, and delete separator icons, as well as one to analyze table structure.  If creating recognition areas manually, click in the table and use “analyze table structure” to automatically place the vertical and horizontal separators. 
If separator lines divide the area into cells that do not match the original table, cells can be merged or split to reconstruct the table to look like the original.  Select the cells to be merged or split, right click and choose the desired option from the drop-down menu. 
If a vertical or horizontal separator is chosen and another area is clicked with the active separator, that second area turns into a table and the separator will be inserted.  This is a handy way to change multiple areas into tables quickly.
When recognized as text, multiple-columned pages, such as an index with little or no punctuation, tend to form one long paragraph when converted to Word. Tables are useful for organizing the information with cells in Word instead of long chains of words. Put each column into a table and place horizontal separators above each major entry in the index. The tables can then be converted back to text when editing in Word. 
[bookmark: _Toc403043524]Combining multiple PDF documents into one document 
Separate PDF documents can be combined to form one document, such as the reference, index, and glossary into the End Matter.  If a file was so large that it was split into two during scanning, they can be joined into one during the ABBYY process. To combine various documents into one, open the file that is the beginning of the original document.  When all the pages are open, click on the thumbnail for the last page, and then open another file to add the next part in the original document.  The pages will open at the end of the first document. Continue selecting the last thumbnail and opening the next document until the original document is complete.  All the pages will follow one after the other in the order they were opened.  ABBYY the pages as usual and save with a new name. 
[bookmark: _Toc403043525]Splitting an ABBYY FineReader document 
If several original documents have been scanned into ABBYY at the same time, they may need to be edited as separate documents again after they are processed through ABBYY.  If a large document, such as a PDF of an entire book, is to be edited as individual chapters, it can be split through ABBYY. This can be done by processing the pages in ABBYY, selecting the pages to be included in a separate document, and saving them in a new Word or PDF document.
If the pages are adjacent to each other, click on the thumbnail of the first page to highlight it, scroll down to the last page and hold Shift + click. This will select all the pages in between; if you press click without first pressing Shift, it will not select all the pages.  If pages not adjacent to each other are to be saved in one file, hold Ctrl and click on each one individually.  File-Save Document As-Microsoft Word Document.  Only the selected pages will be saved except if only one page was selected. In that case, the entire document will be saved.  Therefore, it seems that it is not possible to save only one page without first creating a new FineReader document with just that page in it. Save the new file and it will automatically open in Word; apply the macro.  
Another option is to create new FineReader documents in ABBYY.  With this method, the newly created documents would be processed through ABBYY after being split. See Help on the toolbar, click on Help, Working with ABBYY FineReader, Splitting an ABBYY FineReader Document for specific instructions.
[bookmark: _Toc403043526]Reading and Saving the new document
When finished, click Document and choose Read in the dropdown menu.  All the pages with recognized areas will be read. To save the completed document, File-Save Document As-Microsoft Word Document.  All the pages will automatically be selected and saved to the name of the original PDF. Type a new name to change it and save.  It will open in Word, ready to have the macro applied. 
If only certain pages are to be saved, after Read, select the pages to be saved and proceed with the Save procedure.  Abby 11 will not save a single page in a separate document. Refer to Splitting an ABBYY FineReader Document in the previous section. 
[bookmark: _Toc403043527]Reformatting for editing
Previously in Word 2007/2010, a macro was used to strip out any strange formatting styles in order to simplify the document for editing. In Word 2013, a few simple steps takes the place of the macro, but must be done in order to create a document that can be easily edited by staff and, in turn, read by screen readers correctly. Those steps are:
1. Clear section breaks by doing a find and replace:
a. Find “^b” and replace with either “^p” (paragraph mark) or “^m” (manual break). Replace all. This must be done first so that all further changes affect the whole document and not just whatever section you are in.
2. Select “All” and clean up formatting:
a. Under “Page Layout”, put the document into one column and change margins to “normal”. Check orientation if necessary, verify it is in “Portrait”.
b. “Clear Formatting” under styles. 
c. Change font to a universal font choice, Calibri, Arial, or Times New Roman, size 11. When the macro is not used, other selections where formatting was removed, such as footnotes, will go to a default font and will need to be changed to the font of choice for the document. 
[bookmark: _Toc403043528]Adobe Acrobat Pro
Adobe Acrobat Pro is used for various jobs when preparing documents for students.  
[bookmark: _Toc403043529]Cropping
When a PDF document comes from the publisher, it may not be in a format suitable to give directly to a student.  If the margins need to be adjusted to remove extraneous markings on the pages, use the Crop feature. This is also useful when a document has been scanned to PDF and there are images in the space outside the page magins.
Open the document to be cropped and Adobe Acrobat Pro will automatically open.  Click on Tools; choose Pages on the drop-down menu. The Crop option appears. Click on Crop and then double-click on the text of the page and the Set Page Boxes window appears. Change margins, looking at the diagram to set them just outside the text area.  
Set Page Range to “All” and “Apply to Even and Odd Pages” if all the pages in the document will be cropped to the same size.  If there are binder holes at the center margins or a scanned PDF has more empty space on one side than the other, then set the range to “All” and apply to“Even Pages” or “Odd Pages” after setting the appropriate margins for each option.  This setting will change the margins on all the even or all the odd pages. Click OK.  Save changes.  Close document and open next chapter to be cropped.  . Crop sized may be the same if the pages need the same amount of cropping. For scanned pages, the margins will change from the beginning, center, and end of the book depending on the thickness of the book.
OCR recognition may automatically start after the crop is accepted.  Follow instructions in “Readable PDF Instruction” in Staff Library in SharePoint.
[bookmark: _Toc403043530]Extracting
Large PDF documents, such as entire books, may be too large to reasonably ABBYY in one time period or to send via email, download to a computer, or save as a single file. In this case we extract pages to create separate documents for each chapter.  
To extract pages, open the document and Adobe Acrobat Pro will automatically open.  In the upper left corner, click on “Page Thumbnails.” Scroll down to see where the chapter begins and ends.  Note the page numbers.  Click on the first page to be extracted and scroll to the last page.  Hold Shift and click on the last page to select all the pages in between. Click Extract and a window will appear with the page range that matches your selected first and last pages. No other boxes on this window should be checked.  Click OK and the new document with selected pages will open.  In the Toolbar go to File, Save As, and choose the folder where the new document will be saved.  Name the file according to guidelines and save.  Close the document. 
Each new document should include the entire chapter, including any section materials preceding the chapter and blank pages following the chapter.  Each chapter is named title_of_the_book_ch01, etc.  Beginning single digit chapter numbers with 0 will allow the double digit chapter numbers to follow in numerical order instead of falling between chapters 1 and 2. All pages with Roman numerals as numbers should be extracted as Front Matter (FM). The glossary, dictionary, endnotes, answers to questions, or other resource materials a student is likely to use should be extracted as separate documents. Information at the back of the book such as indices or references are included as End Matter (EM). Check with a staff member if you are unsure which pages to include in the EM or saved separately.     
The original document will still contain the pages that have been extracted.  Select the next set of pages and follow the same process.  Once the first document has been named, all subsequent documents are named by clicking on the first name and changing the chapter number or other designation at the end of the file name.  Repeat until the whole book is divided into separate chapters.  Load to SharePoint in the appropriate folder. 
[bookmark: _Toc403043531]OCR Recognition
Please refer to “Readable PDF instruction” located in Staff Library. This offers additional information and screenshots of how to use this function. When a PDF book will be given to a student, it is important to make sure that the pages can be read with the PDF Aloud tool.  All pages must have OCR recognition turned on with the columns or other sections of the text read in the correct order.  If the document needs to be cropped, do it before running OCR recognition.
[bookmark: _Toc403043532]Scanning documents 
Scanners are used to create a PDF document from pages of paper or books.  The PDF copy may be converted to Word through ABBYY FineReader 11 or converted to a readable PDF through Adobe Acrobat Pro.  There are three scanners: the Fujitsu fi-6140 scanner on the counter next to computer station 3, the Konica Minolta Bizhub 363 printer/scanner in the lobby, and the Epson DS-50000 flatbed printer on the counter next to computer station 1. 
[bookmark: _Toc403043533]Fujitsu fi-6140 
The Fujitsu scanner scans sheets of single or double-sided paper.  To create a readable PDF use Adobe Acrobat Pro.  To create a Word document use ABBYY FineReader 11.  
Before opening Adobe Acrobat Pro or ABBYY FineReader 11, press power button to turn on scanner. Press function button to see a “1” appear in the top window next to “check.”  If you begin and scan and the scanner is not recognized, close the program and turn the scanner off. Close the program and then turn the scanner on again; wait until the 1 is in the window, and reopen the program.  
Set pages to be scanned in top tray with pages upside down, facing the back of the scanner.  Make sure the paper catcher at the front of the scanner is folded out and the extension is also pulled out.  The extension keeps the pages from flying to the floor, backing up into the roller, or getting out of order.
[bookmark: _Toc403043534]Readable PDF
Open Adobe Acrobat Pro and click on “Create.” In the drop-down box choose “PDF from scanner,”  “configure presets.”  A window will open giving the input options.  For double-sided documents choose “both sides” and color mode is “grayscale.” Save. Close.  Click on “Create” again and select “PDF from scanner”-“grayscale document”. “Scan.”  The paper will move through the scanner and the images will appear on the screen. 
The document opens in Acrobat.  Click on Tools on the toolbar, and choose Text Recognition in the drop-down menu. Click In this File; a Recognize Text window appears.  Click OK. The PDFaloud toolbar may appear. Choose options to hear the document read.
[bookmark: _Toc403043535]Word document
Open ABBYY FineReader 11 and click on Scan on the toolbar.  A settings page appears and all options are automatically selected.  If the pages are double-sided, under “Multi-page scanning” check “Duplex Scanning.”  If they are single-sided, uncheck the duplex box or delete the blank pages after scanning and before saving.  Scan.  The pages will roll through the scanner and the images will appear as pages on the navigation pane of the ABBYY screen.  Once the pages have moved through the scanner, close the scan page and they will continue to be processed. When finished scanning, ABBYY as usual. Save document and apply macro according to instructions in ABBYY Finereader11, “Applying the macro.” 
[bookmark: _Toc403043536]EPSON DS 50000
This large-size scanner is used for over-sized textbooks and material that cannot be scanned using the Konica. To scan a print page to form a readable PDF: 
1. Turn on scanner and make sure the scanning area is free of debris or other materials. 
A. Wait for the green ready light to stop blinking. 
2. Launch ABBYY FineReader 11. 
A. It can be found on the windows program tab on the bottom left hand side of the screen.    
3. Place the book flat on the scanner. 
A. For a large textbook (11" x 17"), place the left page against the left ruler. 
B. For smaller books or papers, use the lines on the top ruler to place the spine of the book. 
C. NOTE: It is extremely important to make sure that the book is flat AND the spine is on the line so the text will fit (clearly) on one page. 
4. Once ABBYY is launched, in the Tasks window find "Scan to searchable PDF." 
5. Click on "Scan to searchable PDF." 
A. A settings screen will appear on the page. Resolution is automatically set for 300 dpi.
B. Under Scanning Mode choose "Color." 
C. Under Image Preprocessing, all boxes should be checked. Under Multi-Page Scanning, uncheck Duplex scanning.
6. After the scanning is complete, close the settings pop-up. Note: scanning may take up to 30 seconds to complete. 
7. ABBYY will begin to analyze the page for text and images. 
A. The scanned pages will be split into separate pages. 
B. For each page there will be 2 pages, one for the analyzed information and one for the PDF copy. 
C. Save the file as a PDF.
D. The PDF should open in Abdobe acrobat. If not, click on the PDF on the right side.
8. The PDF should already be readable. 
A. To check,  click on tools in the top right hand side of the page on the toolbar. 
B. Next, a sidebar will appear on the far right hand side. Click on "PDFaloud toolbar." This should be the last option. 
C. Another menu bar will appear. 
D. Click on the Click and Speak icon. It should be the very first option in the list. 
E. Click on a piece of text and PDF should begin to read it. The text being read will be highlighted in yellow. 
F. If text is readable, then this document can be saved. If it is not readable refer to the next steps. 
9. If the text is not readable, click on "Text recognition" under the Tools tab and another menu bar will appear. 
A. Click on "In this file" which should be the 1st option in the sidebar. 
B. Next, a pop-up will appear. 
C. Click "All pages" and then "OK." 
D. Adobe will then process each page and make it readble. 
[bookmark: _Toc403043537]Konica Minolta Bizhub 363
Books and other bound or oversized materials can be scanned as images that become non-readable PDF documents through the Konica Minolta Bizhub 363 in the lobby.  The readability will be turned on when the scan is processed through Adobe Acrobat Pro. When processed through ABBYY, a Word document can be created.
The file is emailed to the staff member who will download it from the email attachment and convert it to text.  If you are unsure who will receive it, ask the staff member who has given you the task. If a chapter is too large to send as one file, split it into smaller sized files, named accordingly.
There are two methods of scanning.
[bookmark: _Toc403043538]Method 1-Book scan setting
This method scans each page separately so they are split in the PDF document.  It can handle larger files for longer chapters. It is the preferred method for scanning books for alt-text production.
Settings:
1. Type in password using keys on pad, not on the screen.  Press OK on screen; Press Login on screen.  
2. Press FAX/Scan on pad.
3. Press the email address of the staff member who will receive the document.
4. Press Mode Memory button on pad to the right of the screen.
5. Press Book Scan on screen.  OK. 
6. Press Scan Settings on bottom left of screen, highlighted in green.
7. Press Document Name on the right of the screen. Press Delete to remove previous name before entering new file name. Type in book title and chapter number using screen. OK.
8. Press OK again.
Scanning:
9. Place book on scanner glass with middle of binding lined up at the 8½ mark (blue arrow) on the measurement ruler above the glass.  The top of the book pages should be right against the top edge of the glass. Be very careful to place the book at the proper mark or parts of the page will not scan well.  The inner margin on one of the pages or the top/bottom of the book may be missed.  The scan cannot be used when parts of the page are missing.  If you are unsure how to place a book, scan and send a page or two and ask the staff member to check it to make sure the placement is working well before scanning the whole chapter. 
10. Press the blue Start button to begin scanning. Carriage moves back and forth twice so each page in the book is scanned individually. Avoid looking at the light.  
11. When the second light goes out the page is scanned. Lift the book, turn the page, and replace it on the glass to scan the next page. Make sure it is the next page and no pages are skipped, scanned twice, folded when scanned, or pieces of paper are stuck on the pages to be scanned. 
Sending:
12. When finished scanning the chapter, press Finish.
13. Press the blue Start button on the pad to send the document as an email attachment.  
14. Check with the staff member whose email is listed to make sure file arrived in email.  Sometimes it takes a few minutes for a file to transmit, especially if it is large.  If a file does not arrive within a half hour or so, rescan the pages, making the file smaller by splitting it into two documents.
[bookmark: _Toc403043539]Method 2-Single page scan setting
This method can only store and send up to 15 pages (scans) at a time.  For smaller chapters, this setting works well. Keep track of the number of pages scanned with the counter on the screen. Facing pages scan as one PDF image and may need to be split when converted to text.
Settings:
1. Type in password using keys on pad, not on the screen.  Press OK on screen; Press Login on screen.  
2. Press FAX/Scan on pad. 
3. Press the email address of the staff member who will receive the document.  
4. Press Scan Settings on bottom left of screen, highlighted in green. 
5. Press Document Name on the right side of the screen.  Press Delete to remove previous name before entering new file name. Type in book title and chapter number using screen. OK.
6. Press OK again.
Scanning:
7. Line corner of book page to be scanned to the top left corner of the glass.  There is a white arrow on the edge of the glass showing where to place the book.
8. Press blue Start button to begin scanning.  Carriage moves back and forth once; avoid looking at the light.  
9. When the light goes out the page is scanned. Lift the book, turn the page, and replace it on the glass to scan the next pages. Make sure it is the next page and no pages are skipped, scanned twice, folded when scanned, or pieces of paper are stuck on the pages to be scanned. 
10. The memory can only send 15 pages at a time.  Continue with this process until 15 pages have been scanned or the chapter is completed, whichever comes first. There is a counter on the screen to tell how many pages have been scanned. 
Sending:
11. When finished scanning the pages to be included in the file, press Finish.
12. Press the blue Start button on the pad to send file as email attachment.
13. Check with staff member whose email is listed to make sure file arrived in email.  Sometimes it takes a few minutes for a file to transmit, especially if it is large.  If a file does not arrive within a half hour or so, rescan the pages, making the file smaller by splitting it into two documents.
[bookmark: _Toc403043540]PowerPoint Conversion to Word
Students who cannot access information in PowerPoint  (PPT) documents request conversion to Word.  This is done with ABBYY FineReader11. When the PowerPoint presentation contains dynamic content, extra care should be taken to include the information that may remain hidden in the converted Word document.  Also, many PowerPoints have links to browser addresses where students find more information, and those links must be included in the final document.  Notes in the section below the slide should be copied and pasted on the Word page.
[bookmark: _Toc403043541]ABBYY the PDF
First, create a folder to organize the documents to be created from the PowerPoint and name it according to the name of the PowerPoint document. From this folder open the PowerPoint document and save as PDF.  Then launch ABBYY and open the PDF; continue according to ABBYY instructions.  IN the text, notice icons that represent links to Web addresses or other special directions, and save the icons as pictures.  Then, the picture will remind the person editing to retrieve the link or replace the icon with the designated wording. Apply the macro, beginning page numbering with Slide 1.  Save. 
[bookmark: _Toc403043542]Editing the Word Document
To edit the Word document, open the Word and original PowerPoint documents. The left side navigation window of the PPT should be set to view the thumbnail slides. Notice that slides with a star indicate dynamic content, meaning the content shifts and changes with information coming into the slide or moving so items underneath are revealed. 
All dynamic content must be included in the final Word document. To view dynamic content, click on the PowerPoint and run the slide show; View-slide show.  The slide show will run full screen.   Scroll down through the slides to see how the information is revealed and decide how to organize it on the Word page.  To exit the slide show, press Escape. 
When editing the Word document, change “Page” to “Slide” and refer to the original PPT to correct the slide numbers so they agree with the PPT.  Make sure all information on the original slide is included in the edited slide. Text or image boxes on the PPT slide can be moved to see what is underneath. You may be able to copy and paste information from the PPT into the Word document during editing.  Correct font and size accordingly, often by clicking on Clear Formatting button on the top toolbar (next to the Shrink Font icon).  Apply page breaks; do not add headings in PowerPoint conversions. 
Many PPTs use bullets and numbering to order information.  For simplicity, use hyphens rather than numbers for lists when possible. Use numbered bullets if the PPT list is numbered.
Use the PPT document to find links and place them in the Word document.  Right click on the link in the PPT; choose “copy link.” Paste it into the Word document next to the icon to represent it.  Delete the icon and name it what it represents—article, video, pronunciation, etc.  Make sure the actual URL has pasted into the document and it is active. The entire URL should be blue underlined without spaces.  If any part of the address is not blue, then it is not recognized as part of the URL.  Delete spaces and add a space at the end of the address to see if it connects.  If not, then ask a staff member for help. 
[bookmark: _Toc403043543]Braille documents
Documents are provided in Braille for students who request that format.  There are two steps to preparing a document in Braille: editing the document and embossing it. There are two Braille software programs that can be used on the Viewplus Max embosser.  
[bookmark: _Toc403043544]Editing the original document
The original Word document may contain formatting that will be confusing for a Braille user to follow.  This is especially pertinent for exams when the student will be typing answers into the original electronic document using JAWS while following along with the embossed Braille translation. Whether the student will be using both JAWS and embossed copies or only the embossed pages, certain edits should be made to the original document.
1. It is important to left justify all lines, as embossing takes up more space than regular printing. An indentation of the text wastes space on the paper and may be confusing for the student to find where the wording begins. 
2. Change multiple columns to a single column. Make sure the information flows in the proper order when the columns are changed. 
3. Shorten long underscored blank lines; three underscores are sufficient to indicate a blank line.  
4. Remove page and section breaks; they will be added as needed after the Braille translation. Leave the original page/slide numbers so the student can reference where in the document they are according to the original pagination of the source document.
5. Remove headers and footers. If there is important information (the document name for instance) then move that to the first line of the document.
6. Remove images, photographs, and tables. Convert tables to descriptions or columned data. Indicate that a graphic has been removed by inserting “(image removed)” in the text.
7. IMPORTANT: All Word formatting must be stripped, including lists. Number everything by hand, if necessary; do not use any Word formatting shortcuts. For bulleted lists, use one n-dash (“-”) to replace the bullet mark.  
[bookmark: _Toc403043545]Tiger Braille Software
Tiger software is designed to integrate with MS Word.  Open a .doc, .docx or Word-compatible (.txt,.rtf) document using Word. The standards for left-justifying apply, and be careful of forced page breaks as the layout will change dramatically when you translate the document into Braille. Do the following:
(NOTE: embossers are loud. Do NOT emboss documents while exams are taking place.) 
1. Go to the "Add-Ins" tab.
2. On the Ribbon on the far left if a "Tiger" drop down menu. You can change settings here if you need to (please do not do so without checking with a team leader first!).
3. Choose "Translate Document".
4. This will run an automated translation macro, and you will see the text and format change from a standard system font to Braille font. It might take a while for larger documents.
5. Once the translation has run, do the following:
a. Under “Page Layout”, fix:
i. Columns (one column)
ii. Size (11.5” x 11”)
iii. Orientation (portrait)
iv. Margins (1.24” for top, 1” for bottom, right and left)
b. Add a header:
i. Make sure “same on all pages” is checked
ii. Add text: “Page [page#]” (use “insert page number” so it paginates correctly)
iii. Right justify
iv. Size: 28 pt.
v. Font: Braille29
vi. Set “Header from top” measurement to “0.5”
vii. Check for odd page breaks or section breaks
6. Make sure the printer chosen is the "ViewPlus Max" which is the name of the embosser.
7. Set the printer settings:
a. Page size (11.5” x 11”)
b. Media type (“Default 1 – Braille paper”)
8. Print the document. Keep an eye on the paper as it prints out so it does not get stuck or feed back into itself. (If the paper is not feeding evenly, press the cancel button (the X) on the side of the embosser). 
9. When finished, press the up arrow key. 
10. Gently separate the paper along the perforated line. 
11. Turn the embosser off. 
12. Carefully fold the embossed pages.  Tear off the sides (the “ears”).  Leave the pages attached so they do not fall out of order. 
13. Refold them if necessary so page 1 is on top, facing out. Also, write in the initials of the student this is for and the assignment name at the top. 
Creating Tactile Graphics Using Illustrator and PIAF
Equipment/Software
Adobe Illustrator, a word processor that has Braille type installed, a laser printer, a PIAF machine, and PIAF thermal paper. 
Skills needed
A basic understanding of Illustrator that includes placing images, using layers, Bezier curves, the pen and line tools, and aspects such as fill and stroke.
Process
1. Obtain a digital copy of the image needed, either by scanning or downloading. It can be PDF, Tiff, PNG, or JPEG. 
2. Open new document in Illustrator. Make sure that the document size and orientation is correct when you create the new document. 
3. [bookmark: _GoBack]Place the digital image as a separate layer, and change its opacity to about 50%, give or take. Enough that you can see it clearly but not so much that it will be confusing when you put other lines on top of it. Lock that layer.
4. DO NOT USE THE TRACE TOOL! Automatic tracing will create an image with a lot of extraneous points and curves.  If the image is very, very simple this might work but experience has shown that it usually creates a sloppy image that needs a lot of clean up. 
5. Create a new layer specifically for the image you draw. Using the pen and line tool, trace the lines by hand. 
a. A good stroke width is between .5 and 4 points. Any smaller than .5 and the PIAF process will not pick it up well and over 4 points will result in the line “sinking” from the weight of the toner on the PIAF paper. 
b. Lines placed too closely together will bleed into each other when PIAF’d. Try to keep at least a 2 point width distance between lines. 
c. Corners will always have a rounded element to them when PIAF’d, try to keep this in mind when creating charts with lines on them that overlap or zig-zag a lot.
d. Use different width strokes on lines to indicate different elements. For instance, in a math graph, use .75 or even .5 to draw the graph lines, then a 2 point stroke to create the math curve being shown. 
e. If the image is complex or has many features, use a different layer for each different group of elements. For instance you might have one layer for the grid lines of a math graph, and another layer for the actual curve. This way you can “lock” elements such as the grid lines once they are in place while you draw other aspects. This is also helpful if you have many of one type of image to do, because you can create a template with the set layers (such as grid lines) already created.
6. Add Braille text to the document if necessary.
a. If there is a lot of text on the image (math equations, explanations, descriptors, labels) keep in mind that each “chunk” will be added separately. This is so you can move different text elements around the image to fit in where needed.
b. Open a word processing program and configure the text into Braille (Using MS Word and the Tiger plugin, type out the text and then translate it into Braille). Make sure interlinear is turned OFF. You only want the Braille text, nothing else. 
c. Highlight and copy the Braille text.
d. Create a new layer in the Illustrator document just for text. Paste the Braille into the layer. Keep in mind that it probably won’t land right where you want it, you will have to move it around manually for best placement. At this point you can also resize the Braille text box, but don’t make it too small or the Braille dots won’t PIAF well enough to be read. 
e. If you have a lot of text that you need to keep straight (such as with a map), create another layer and use that to label text blocks/features you need to keep track of. When it comes time to print, you can turn this layer off (as long as the settings are to not print hidden layers). 
7. Do a few test prints on regular paper to make sure the size/layout works.
8. When everything is adjusted, print the image on PIAF thermal paper using a laser printer. 
9. Run the thermal paper through the PIAF machine.
10. If you have a lot of images to print, let the PIAF machine rest for 15 to 30 minutes every 10 pages or so. 
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